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ABSTRACT 

This research investigates the structural behavior of a reinforced concrete box culvert under 

variable hydraulic conditions typical of urban drainage systems in Benin City. The study 

addresses the problem of culvert deterioration caused by internal sedimentation, foundation 

scour and variable headwater levels. The aim of the research was to develop a data-driven 

model that links observable hydraulic conditions to quantifiable structural responses, thereby 

improving performance evaluation and maintenance prioritization. 

To achieve this, field investigations were conducted at the Ogba River drainage corridor to 

determine practical ranges for the three hydraulic variables. Response Surface Methodology 

(RSM) was employed to generate a design matrix with 20 experimental runs. Finite Element 

Analysis (FEA) was performed for each run to simulate the resulting wall shear force 

response. Six center points were observed in the matrix to ensure adequate degrees of freedom 

for estimating pure error and testing lack of fit in the ANOVA. 

The RSM model achieved a coefficient of determination (R²) of 98.6%, confirming the 

model’s high predictive accuracy. Results showed that the headwater level had the most 

significant effect on the wall shear force. The effect of the headwater level on the wall shear 

force is amplified by its interaction with foundation scour. Optimization analysis identified 

critical combinations of the variables that produced maximum WSF values greater than 70 

kN/m, indicating the threshold beyond which the culvert’s structural integrity may be 

compromised. The developed model provides a quantitative framework for predicting wall 

shear forces based on measurable hydraulic conditions, offering a practical decision-support 

tool for culvert maintenance and management in resource-constrained urban environments 

such as Benin City. 
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CHAPTER ONE 

INTRODUCTION 

1.1  BACKGROUND OF STUDY 

Response Surface Methodology (RSM) is a powerful statistical tool for modeling the 

relationship between multiple input variables and a system’s response. Widely used in 

manufacturing and materials science for process optimization (Myers et al., 2016), it is 

increasingly applied in civil engineering to analyze complex, nonlinear systems involving 

interacting variables (Dhami et al., 2021). RSM is now used for optimizing mix designs, 

modeling pavement performance, and in this study, it is used to evaluate structural behavior 

under real-world deterioration scenarios. 

In drainage infrastructure, box culverts are essential components that allow stormwater to 

safely pass under roads and embankments. They are designed to carry not just water, but also 

heavy overburden and traffic loads. However, these culverts are exposed to varying 

environmental and loading conditions over time. In regions like Benin-City, heavy seasonal 

rainfall, insufficient maintenance and urban runoff contribute to common problems such as 

internal sedimentation, foundation scour, and increased headwater levels. These hydraulic 

conditions alter the internal flow dynamics and support conditions of the culvert leading to 

increased wall shear forces, which, if not properly accounted for, may result in structural 

failure (Arneson et al., 2012; USACE, 2010). 

Conventional inspection methods often rely on visual assessments; the observed hydraulic 

parameters such as sediment buildup, foundation scour, and headwater level are typically 

considered in isolation. However, the interactions between these variables introduce nonlinear 

effects that are not captured by basic engineering approximations. For instance, increased 
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sediment raises headwater, which increases hydrostatic pressure; meanwhile, scour removes 

soil support at the base, changing the structural boundary conditions and further elevating 

internal forces (FHWA, 2012; fib, 2013). Traditional assessment frameworks lack the ability 

to model these coupled behaviors, which results in maintenance decisions that may either 

misallocate resources or overlook potential structural risks. 

To overcome these limitations in modelling coupled behaviors, Response Surface 

Methodology (RSM) is employed, often utilizing data from numerical simulations. While 

these simulations can predict how a culvert behaves under varying combinations of adverse 

hydraulic conditions, they typically produce large amounts of case-specific datasets that are 

difficult to generalize. RSM complements these datasets by generating a statistical model that 

reveals trends, interaction effects, and critical thresholds across a range of conditions in a 

simple, usable format (Montgomery, 2017). This hybrid approach makes it possible to link 

field observations directly to structural vulnerability based on reliable statistical information. 

In Benin-City, where culvert inspections are mostly visual and budgets are tight, this 

methodology is particularly valuable. With RSM, infrastructure managers can move beyond 

qualitative assessments and prioritize culvert repairs based on quantifiable structural risks 

linked to what is visibly observed. Therefore, this research not only provides a practical tool 

for culvert evaluation but also a template for scalable, data-driven infrastructure assessment 

in similar urban settings across developing regions. 

1.2  PROBLEM STATEMENT 

Hydraulic structures, such as culverts, often suffer from adverse hydraulic conditions such as 

internal sediment buildup, foundation scour, and variable headwater levels during storms. 

These issues typically arise as a result of the culvert’s age, flow patterns, specific 
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environmental conditions and location within the drainage network (InfraSteel, 2013). These 

hydraulic and foundation conditions combine to affect the hydrostatic pressures on the culvert 

walls and the foundation's soil support, directly influencing the shear forces within the walls. 

This, in turn, impacts the safety and serviceability of the culverts. 

In practice, these hydraulic conditions are rarely evaluated in combination, leading to the 

underestimation of the potential structural risks. Many assessment models used are designed 

for different climates and maintenance regimes, and do not reflect the typical environmental 

and infrastructure conditions in Benin-City. Moreover, the relationship between these 

variables and wall shear force is non-linear and complex. Traditional linear methods fail to 

capture this complexity, rendering current risk assessments less reliable. 

Local engineering approaches have also been found to lack adequate data-driven systems that 

link visible signs - like sediment buildup or foundation scour depth - to internal structural 

stress. This has resulted in poor maintenance decisions such as inefficient spending or the 

neglect of risk-prone box culverts. 

Statistical techniques offer a powerful means to overcome these limitations by providing data-

driven methods to model the non-linear relationships between visible hydraulic conditions and 

the resulting internal wall shear forces. These methods facilitate the development of accurate 

risk assessment tools tailored to specific local conditions. This will bridge the gap between 

observable signs and hidden structural stress in order to inform better maintenance strategies. 

There is a critical need to apply these statistical techniques to comprehensively model the 

combined effects of adverse hydraulic conditions on the wall shear forces of culverts. By 

modelling the interactive influence of these conditions, this research offers a robust decision-

support tool for culvert maintenance in Benin-City and similar urban environments. 
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1.3  AIM AND OBJECTIVES 

The primary aim of this research is to perform a data-driven assessment of wall shear forces 

in box culverts under variable hydraulic conditions.  

The specific objectives of this research are as follows; 

1. To locate and assess the hydraulic conditions of the existing box culvert at Ogba River. 

2. To define the practical ranges needed for each input variable based on the assessment. 

3. To generate possible combinations of conditions from the defined ranges. 

4. To simulate the shear force response on the culvert walls under each combination of 

conditions. 

5. To build a response surface model from the generated datasets and analyze it in order 

to determine how each input variable - alone and in combination - affects the wall 

shear force. 

1.4  SCOPE OF THE STUDY 

This research assesses the combined influence of variable hydraulic conditions on the wall 

shear forces of an existing reinforced concrete box culvert at Ogba River. It focuses on three 

hydraulic conditions namely: internal sedimentation, foundation scour and headwater level. 

Response Surface Methodology (RSM) is employed as the statistical technique to analyze and 

model the interactions between these conditions and the wall shear force. 

However, the scope of this research is specifically limited to box culverts, excluding analysis 

of other culvert types. Also, it does not examine any structural response other than the shear 

force of the culvert walls. This research excludes any deterioration mechanisms unrelated to 

the defined hydraulic conditions. Furthermore, this research does not cover hydrological 

modeling for estimating flow patterns or headwater levels. 



 

5 
 

1.5  JUSTIFICATION OF THE STUDY 

This research is driven by the urgent need to improve the safety and serviceability of essential 

drainage infrastructure, such as box culverts, in urban environments like Benin-City. Existing 

assessment methods often fail to account for the complex and interactive effects of prevalent 

adverse hydraulic conditions, often leading to potentially inaccurate structural risk 

assessments and inefficient maintenance strategies. Furthermore, the absence of data-driven 

tools tailored to local environmental and infrastructure conditions hinders effective decision-

making, resulting in the misallocation of limited resources and potential neglect of high-risk 

structures. 

This research establishes a clear relationship between observable hydraulic conditions and the 

internal structural demand of box culverts. It also provides a predictive model for efficient 

risk identification, proper allocation of resources and prioritized maintenance planning. 
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CHAPTER TWO 

LITERATURE REVIEW 

2.1  INTRODUCTION 

This chapter presents a comprehensive review of literature relevant to the assessment of wall 

shear forces in box culverts under variable hydraulic conditions. The review is tailored to the 

urban hydraulic environment of Benin City; a region experiencing intense rainfall events, 

rapid urbanization and drainage stress. The review is structured to cover key areas including 

Response Surface Methodology applications in civil engineering, adverse hydraulic 

conditions affecting culvert performance, Finite Element Analysis applications in hydraulic 

structures and infrastructure management practices in developing countries. The adverse 

hydraulic conditions explored are internal sedimentation, foundation scour and headwater 

variation, including their interactive influence on culvert performance. The review emphasizes 

scholarly literature and technical studies from Nigerian and African contexts to provide 

relevant insights for the study area. 

2.2  HYDRAULIC INFRASTRUCTURE CHALLENGES IN NIGERIA AND 

SUB-SAHARAN AFRICA 

Nigeria's hydraulic infrastructure faces significant challenges due to rapid urbanization, 

climate change impacts, and limited maintenance resources. Adeloye et al. (2016) identified 

inadequate drainage infrastructure as a major contributor to urban flooding in Nigerian cities, 

with particular emphasis on the need for improved culvert design and maintenance practices. 

Their study of drainage systems in Lagos highlighted the vulnerability of existing 

infrastructure to extreme weather events and population growth pressures. 
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In Benin City specifically, Enaruvbe and Atafo (2018) conducted a comprehensive study of 

land cover transition and fragmentation in the River Ogba catchment, documenting significant 

changes in urban development patterns that have impacted natural drainage systems. Their 

findings revealed that rapid urbanization has increased surface runoff and altered flow 

patterns, placing additional stress on existing hydraulic infrastructure including culverts and 

drainage channels. 

Aziegbe (2006) investigated the morphological response of watersheds to urbanization in 

Benin City, focusing on channel modifications and their impact on flood risk. The study 

documented how urban development has altered natural drainage patterns, leading to 

increased peak flows and reduced lag times, which directly impact the performance of 

hydraulic structures like box culverts. This work provides crucial context for understanding 

the hydraulic conditions affecting culverts in the study area. 

Ogbomida et al. (2019) examined the impact of urbanization on flood risk in Benin City, 

identifying inadequate drainage infrastructure as a primary factor contributing to recurrent 

flooding. Their study emphasized the need for improved assessment and maintenance of 

existing hydraulic structures, to reduce flood vulnerability in urban areas. 

Across broader Sub-Saharan Africa, similar challenges have been documented. Ndambuki et 

al. (2016) investigated urban drainage challenges in Kenyan cities, highlighting common 

issues including inadequate design standards, poor maintenance practices, and limited 

financial resources for infrastructure upgrades. Their findings are relevant to the Nigerian 

context, as they identify systemic issues affecting hydraulic infrastructure performance across 

the region. 
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2.3 CULVERTS: THEORY, TYPES AND FAILURE MECHANISMS 

2.3.1 Definition and Functions 

Culverts are hydraulic structures that allow water to flow under roadways, railways, 

embankments, or other obstructions. Unlike bridges, culverts are typically buried structures 

that convey water through an artificial channel, serving as critical components of drainage 

infrastructure in urban and rural settings (FHWA, 2012). In essence, a culvert functions as a 

short bridge, but its design and performance are fundamentally governed by hydraulic 

principles rather than purely structural considerations. 

The primary functions of culverts include: 

1. Conveying stormwater runoff beneath transportation infrastructure 

2. Maintaining natural drainage patterns and preventing flood accumulation 

3. Protecting roadway embankments from erosion and washout 

4. Accommodating seasonal and extreme flow events 

In urban environments like Benin City, culverts serve an essential role in managing the high 

volumes of surface runoff generated by impervious surfaces, particularly during intense 

rainfall events characteristic of tropical climates. 

2.3.2 Hydraulic Classification 

Culverts can operate under different flow conditions depending on headwater levels, tailwater 

conditions, and barrel characteristics. The Federal Highway Administration (FHWA, 2012) 

classifies culvert flow into two primary categories: 

1. Inlet Control: 

Flow capacity is controlled by the inlet geometry, headwater elevation, and barrel 

characteristics. Under inlet control, the culvert barrel flows partially full, and the outlet 
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conditions do not affect the flow capacity. This condition typically occurs when the 

culvert barrel can convey more flow than the inlet will accept. 

2. Outlet Control: 

Flow capacity is controlled by the downstream conditions including tailwater 

elevation, barrel characteristics, outlet geometry, and barrel roughness. Under outlet 

control, the culvert typically flows full for at least part of its length, and increasing the 

inlet size will not increase the flow capacity. 

Understanding the hydraulic control mechanism is crucial for predicting culvert performance 

and assessing vulnerability to adverse conditions such as those examined in this study. 

2.3.3 Structural Classification and Geometry 

Culverts are constructed in various shapes, each offering distinct hydraulic and structural 

advantages depending on site conditions, design requirements, and construction constraints. 

1. Box Culverts (Rectangular): 

Box culverts consist of reinforced concrete sections with rectangular cross-sections. 

They offer several advantages including: 

i. High structural efficiency under heavy embankment loads 

ii. Flat invert suitable for fish passage and sediment transport 

iii. Easy construction using precast or cast-in-place methods 

iv. Optimal hydraulic efficiency for wide, shallow flow conditions 

Box culverts are particularly common in urban settings where multiple barrels may be 

required to accommodate large discharge volumes. The culvert examined in this study 

is a reinforced concrete box culvert located at the Ogba River corridor. 
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Figure 2.1: Typical box culvert showing cross-section and flow characteristics 

(Source: EW Enterprises, 2024) 

2. Circular Culverts (Pipe Culverts): 

Circular culverts, typically constructed from reinforced concrete, corrugated metal, or 

plastic, are the most common culvert type globally. Their advantages include: 

i. Structural efficiency due to arch action 

ii. Ease of manufacture and cost-effectiveness for small to medium discharges 

iii. Self-cleaning properties due to flow concentration at lower depths 

 

Figure 2.2: Circular concrete culvert in operation during a storm flow event 

(Source: Atlantic Industries Ltd, 2023) 
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3. Arch Culverts: 

Arch culverts feature a curved top and flat or curved bottom, combining structural 

efficiency with improved hydraulic performance. They are particularly suitable for: 

i. Sites requiring large span-to-rise ratios 

ii. Locations with aesthetic or environmental constraints 

iii. Situations requiring natural stream bed preservation 

 

Figure 2.3: Arch culvert structure showing efficient span-to-depth ratio (Faddis 

Concrete Products, 2025) 

4. Elliptical Culverts: 

Elliptical culverts offer a structural compromise between circular and box culverts, 

with the following advantages: 

i. Reduced headroom requirements compared to circular culverts 

ii. Better hydraulic efficiency than circular sections for shallow flows 
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Figure 2.4: Elliptical culvert profile showing reduced headroom requirements (Source: 

InfraSteel, 2023) 

The selection of culvert shape depends on multiple factors including hydraulic requirements, 

foundation conditions, available construction materials, economic considerations, and site-

specific constraints (USACE, 2010). 

2.3.4 Failure Mechanisms in Culverts 

Culvert failures can result from hydraulic inadequacy, structural deterioration, or a 

combination of both. Understanding these failure mechanisms is essential for developing 

effective assessment and maintenance strategies. 

1. Hydraulic Failures: 

Hydraulic failures occur when the culvert cannot accommodate the design flow or 

when flow conditions deviate from design assumptions. Common hydraulic failure 

modes include: 

i. Overtopping: When headwater levels exceed the roadway elevation, flow 

overtops the embankment, potentially causing catastrophic erosion and washout. 
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This is particularly common in rapidly urbanizing areas where increased 

impervious surfaces generate higher runoff volumes than originally anticipated 

(Adeloye et al., 2016). 

ii. Inlet Blockage: Accumulation of debris, sediment, or vegetation at the culvert 

inlet reduces the effective flow area, increasing upstream water levels and 

potentially causing overtopping or bypass flows. In Benin City, blockage from 

market waste, construction debris, and unpaved road sediments is a recurring 

problem (Aziegbe, 2006). 

iii. Scour and Erosion: High-velocity flows at culvert outlets can cause severe scour 

of downstream channels and undermining of culvert foundations. Foundation 

scour removes soil support, altering structural boundary conditions and increasing 

internal forces (Arneson et al., 2012). In flood-prone areas like the Ogba River 

corridor, even moderate rainfall events can trigger significant scour damage 

(Rawlings and Ikediashi, 2020). 

 

Figure 2.5: Progressive deterioration of culvert outlet due to foundation scour 

(Source: NZ Forest Road Engineering Manual, 2012) 
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2. Structural Failures: 

Structural failures result from inadequate design, settlement, material deterioration, or 

loads exceeding design assumptions. Common structural failure modes include: 

i. Wall Cracking: Excessive shear forces or bending moments in culvert walls can 

cause cracking, particularly at corners and mid-span locations. These cracks may 

propagate over time due to freeze-thaw cycles or continued overstress. 

ii. Foundation Settlement: Inadequate foundation design or unexpected soil 

conditions can cause differential settlement, inducing additional stresses in the 

culvert structure. 

iii. Corrosion and Deterioration: Reinforcing steel corrosion in concrete culverts or 

metal deterioration in corrugated metal culverts reduces structural capacity over 

time. In aggressive environments typical of tropical regions, deterioration rates can 

be accelerated by chlorides, sulfates, and organic acids (Ugwu et al., 2020). 

 

Figure 2.6: A damaged box culvert showing the effects of structural distress 

(Source: Tenbusch Inc., 2013) 
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2.4  BOX CULVERT DESIGN AND PERFORMANCE 

Box culverts serve a vital role in managing surface water runoff in Benin City, particularly 

during the extended rainy season (Aziegbe, 2006). Given the city's unplanned urban expansion 

and increasing impermeable surfaces, culverts are regularly overwhelmed by stormwater 

volumes beyond their design capacity. Land-use transitions in the Ogba River catchment have 

also significantly increased sediment transport and hydraulic loading on existing culvert 

infrastructure (Enaruvbe and Atafo, 2018). 

Moreover, Rawlings and Ikediashi (2020) identified the erosion of riparian zones and the 

encroachment of informal structures along floodplains as critical stressors on culvert 

foundations in Benin. This process, often neglected in local inspections, leads to the 

progressive undermining of culvert support through foundation scour. 

Box culverts are widely used in Nigeria and across Africa for their structural efficiency and 

construction practicality. Okonkwo and Agunwamba (2021) conducted a comprehensive 

study of concrete box culvert design practices in Nigeria, highlighting the need for improved 

design standards that account for local environmental conditions and construction practices. 

Their work identified common design deficiencies that contribute to premature failure and 

reduced service life. 

The structural behavior of box culverts under various loading conditions has been extensively 

studied. Adedeji et al. (2020) investigated the structural performance of reinforced concrete 

box culverts under different soil conditions in Lagos, Nigeria. Their study used finite element 

analysis to examine the effects of soil-structure interaction on culvert performance, providing 

insights relevant to foundation design and scour assessment. 
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2.5  ADVERSE HYDRAULIC CONDITIONS AFFECTING CULVERT 

 PERFORMANCE 

2.5.1  Internal Sedimentation 

Sedimentation in culverts is a widespread problem in tropical regions, particularly in areas 

with high rainfall and significant urban development. The accumulation of sediments in 

culverts reduces effective flow area, alters internal flow velocity and raises upstream water 

levels. In Benin City, sedimentation is frequently caused by unpaved road networks, market 

waste and construction debris, particularly during storms (Aziegbe, 2006). A local study by 

Enaruvbe and Atafo (2018) documented that sediment load in the Ogba catchment has 

increased by 34% in the last two decades, contributing to frequent culvert overtopping and 

internal pressurization. 

The hydraulic effects of sedimentation on culvert performance have been documented by 

several researchers. Ogu et al. (2019) studied sediment accumulation in drainage channels in 

Port Harcourt, Nigeria, documenting the effects of urban runoff on sediment transport and 

deposition. Their findings revealed that inadequate upstream erosion control and poor land 

use practices contribute significantly to sediment problems in hydraulic structures. 

Ologunorisa and Tersoo (2006) investigated sedimentation problems in drainage systems in 

Warri, Delta State, Nigeria, highlighting the relationship between urbanization patterns and 

sediment accumulation rates. Their study documented how changes in land use and inadequate 

stormwater management lead to increased sediment loads in drainage infrastructure. 

2.5.2  Foundation Scour 

Scour is the localized removal of soil at culvert inlets or beneath foundations. In flood-prone 

areas like Ogba and Sakponba roads where natural vegetation buffers have been lost, 
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foundation scour is a leading cause of hydraulic failure. According to Rawlings and Ikediashi 

(2020), even moderate rainfall events cause bank collapse, weakening culvert support and 

amplifying shear stress on concrete walls due to shifting boundary conditions. 

Foundation scour is a critical concern for hydraulic structures, particularly in tropical regions 

with intense rainfall and significant flow velocities. In the context of culverts specifically, 

Lawal et al. (2020) studied scour problems at culvert outlets in northern Nigeria, focusing on 

the effects of flow concentration and energy dissipation on scour development. Their work 

provided practical insights into scour protection design and the relationship between hydraulic 

conditions and scour severity. 

More recently, Ezeilo et al. (2018) investigated scour problems at bridge foundations in 

southeastern Nigeria, documenting the effects of extreme weather events on scour 

development. Their study highlighted the vulnerability of hydraulic structures to scour during 

flood events and the need for improved scour assessment and protection methods. 

2.5.3  Headwater Levels 

Variable headwater levels, particularly during high-intensity rainfall, can lead to significant 

increases in hydrostatic pressure inside culverts. This is especially concerning in the Ogba 

River corridor where double rainfall peaks in July and September result in flash flooding. 

High headwater exacerbates pressure on walls and, when combined with sediment and scour, 

creates highly nonlinear structural loading (United Nations, 2016). 

Ogbomida et al. (2016) also investigated flood frequency analysis in Benin City and its 

implications for hydraulic infrastructure design. Their study provided insights into the 

statistical characteristics of flood events in the region and the need for improved design 

standards that account for extreme headwater conditions. 
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2.6  HYDRAULIC INFRASTRUCTURE MANAGEMENT PRACTICES: 

 VISUAL INSPECTION VS QUANTITATIVE MODELING 

In most urban Nigerian settings, including Benin City, culvert inspections are largely visual 

and qualitative. These assessments fail to account for the interactive behavior of hydraulic 

stressors (Ogunleye et al., 2017). Studies from the Federal Ministry of Works and Housing 

note that critical signs like sediment buildup or minor scour are often dismissed due to lack of 

technical tools to translate visible symptoms into structural risk (FMWH, 2014). 

Globally, the shift has moved toward data-driven modeling using statistical and computational 

tools that allow predictive and quantitative evaluations. However, infrastructure management 

in developing countries faces unique challenges related to limited resources, technical 

capacity and data availability. Akintoye et al. (2020) investigated infrastructure management 

practices in Nigeria, highlighting the need for improved assessment methodologies and 

decision-support tools. Their work emphasized the importance of data-driven approaches to 

infrastructure management, which aligns with the objectives of the current study. 

Okafor and Ugwu (2019) studied the application of condition assessment methodologies to 

concrete infrastructure in Nigeria, documenting the challenges and opportunities for 

implementing systematic assessment programs. Their work highlighted the need for practical, 

cost-effective assessment tools that can be applied in resource-constrained environments such 

as Benin City. 

2.7  RESPONSE SURFACE METHODOLOGY 

Response Surface Methodology (RSM) is a collection of mathematical and statistical 

techniques that are useful for modeling and analyzing problems in which a response of interest 

is influenced by several variables and the objective is to optimize this response (Montgomery, 
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2017). RSM was originally developed by Box and Wilson in 1951 for chemical process 

optimization and has since been widely adopted across various engineering disciplines, 

including civil and structural engineering. 

The methodology is particularly valuable when dealing with complex systems where multiple 

factors interact to influence an outcome, and where traditional single-variable analysis would 

be inadequate to capture the true behavior of the system. In the context of hydraulic 

infrastructure assessment, RSM provides a powerful framework for understanding how 

multiple adverse conditions combine to affect structural performance. 

2.7.1  Fundamental Concepts 

1. Response Surface: 

A response surface is a mathematical representation of the relationship between a 

dependent variable (response) and one or more independent variables (factors). 

Mathematically, if we have k independent variables x₁, x₂, .... xₖ, the response surface 

can be expressed as: 

y = f(x₁, x₂, ..., xₖ) + ε               (2.1) 

Where: 

i. y is the response variable 

ii. f represents the true relationship between the response and the independent 

variables 

iii. ε is the random error term 

The goal of RSM is to approximate the unknown function f with a suitable empirical 

model, typically a polynomial function. The response surface provides a visual and 
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mathematical representation of how the response varies across different combinations 

of input variables. 

2. Design Space and Factor Space: 

The design space or factor space is the region of interest in the independent variables. 

This space is defined by the ranges of the factors being studied. In practical 

applications, these ranges are determined by: 

i. Physical constraints of the system 

ii. Economic considerations 

iii. Safety limitations 

iv. Practical operational boundaries 

For the current study examining box culvert performance, the design space is bounded 

by the practical ranges of internal sedimentation, foundation scour, and headwater 

levels that can realistically occur in the field. 

3. Response Function: 

The response function is the mathematical model that describes the relationship 

between the factors and the response. The most commonly used response functions in 

RSM are polynomial models, typically first-order (linear) or second-order (quadratic) 

models. 

First-order model:       y = β₀ + β₁x₁ + β₂x₂ + ... + βₖxₖ + ε              (2.2) 

Second-order model:      y = β₀ + Σβᵢxᵢ + Σβᵢᵢxᵢ² + ΣΣβᵢⱼxᵢxⱼ + ε         (2.3) 

where β₀, βᵢ, βᵢᵢ, and βᵢⱼ are regression coefficients representing the intercept, linear 

effects, quadratic effects and interaction effects, respectively. 
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2.7.2  Experimental Design 

1. Central Composite Design (CCD): 

Central Composite Design is one of the most popular experimental designs for fitting 

second-order response surface models. A CCD consists of three types of design points: 

i. Factorial Points (2ᵏ): These are the corners of the factor space, typically at ±1 

levels 

ii. Axial Points (2k): These are points along the axes of the factors, typically at 

±α levels 

iii. Center Points (nc): These are replicate runs at the center of the design space 

(0 level) 

The total number of experiments in a CCD is: 

N = 2ᵏ + 2k + nc             (2.4) 

For a three-factor design (k = 3), this gives: N = 2³ + 2(3) + nc = 8 + 6 + nc  

2. Face-Centered Central Composite Design (FCCD): 

In Face-Centered Central Composite Design, the axial points are placed at the face 

centers of the factorial space (α = 1). This design is particularly useful when: 

i. Factor levels cannot extend beyond the original factorial levels 

ii. There are physical or practical constraints on factor ranges 

iii. Spherical design region is not required 

The FCCD ensures that all design points remain within the original factor space, 

making it ideal for studies where extreme conditions beyond the defined ranges are 

not feasible or safe to investigate. 
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3. Design Matrix Generation: 

The design matrix is a systematic arrangement of factor level combinations that 

defines which experiments need to be conducted. Each row represents a unique 

combination of factor levels, and each column represents a specific factor. The matrix 

typically includes: 

i. Coded factor levels (usually -1, 0, +1 for FCCD) 

ii. Actual factor levels (real-world values) 

iii. Randomized run order to minimize systematic errors 

2.7.3  Mathematical Modeling 

1. Model Fitting: 

Once experimental data are collected, the response surface model is fitted using 

regression analysis. The general approach involves: 

i. Model Selection: Choosing between first-order, second-order, or higher-order 

models. 

ii. Parameter Estimation: Using least squares method to estimate regression 

coefficients. 

iii. Model Validation: Checking model adequacy and assumptions. 

The regression equation for a three-factor second-order model is: 

y = β₀ + β₁x₁ + β₂x₂ + β₃x₃ + β₁₁x₁² + β₂₂x₂² + β₃₃x₃² + β₁₂x₁x₂ + β₁₃x₁x₃ + 

     β₂₃x₂x₃             (2.5) 

2. Analysis of Variance (ANOVA): 

ANOVA is used to assess the statistical significance of the model and individual terms. 

Key components include: 
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i. Sum of Squares: Decomposition of total variation into model and error 

components 

ii. F-Statistics: Testing the significance of the overall model and individual terms 

iii. p-Values: Probability of observing the data if null hypothesis is true 

iv. R²: Coefficient of determination indicating the proportion of variance 

explained by the model 

3. Model Adequacy Checking: 

Several diagnostic checks are performed to validate the model: 

i. Residual Analysis: Examining residual plots for patterns and outliers 

ii. Normal Probability Plots: Checking normality assumption of residuals 

iii. Lack of Fit Test: Assessing whether the model adequately represents the data 

iv. R² and Adjusted R²: Evaluating model fit quality 

2.7.4  Response Surface Analysis 

1. Contour Plots: 

Contour plots are two-dimensional representations of the response surface that show 

lines of constant response. These plots are particularly useful for: 

i. Visualizing the relationship between two factors while holding others constant 

ii. Identifying optimal operating regions 

iii. Understanding interaction effects between factors 

For a three-factor system, multiple contour plots are generated by fixing one factor at 

different levels and plotting the other two factors. 
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2. Three-Dimensional Surface Plots: 

Surface plots provide a three-dimensional visualization of the response surface, 

allowing for: 

i. Better understanding of the response behavior across the factor space 

ii. Identification of peaks, valleys, and saddle points 

iii. Visual assessment of model curvature and interaction effects 

2.7.5  Applications in Civil Engineering 

Response Surface Methodology (RSM) has emerged as a powerful statistical tool for 

optimization and modeling in various engineering disciplines. Originally popular in industrial 

quality control (Myers et al., 2016), RSM has since been used in concrete optimization (Dhami 

et al., 2021), pavement design, and hydraulic modeling. Montgomery (2017) describes RSM 

as a collection of mathematical and statistical techniques useful for modeling and analyzing 

problems where several independent variables influence a dependent variable or response. 

The methodology has found extensive applications in civil engineering, particularly in 

concrete technology, structural optimization, and infrastructure assessment. 

In the Nigerian context, Okafor and Umeorah (2019) successfully applied RSM to optimize 

the compressive strength of concrete incorporating local pozzolanic materials from Afikpo, 

Ebonyi State. Their study demonstrated the effectiveness of RSM in modeling the complex 

interactions between cement replacement levels, water-cement ratios, and curing conditions 

on concrete strength. Similarly, Adeolu et al. (2021) utilized RSM to investigate the 

optimization of lateritic concrete blocks using Response Surface Methodology, highlighting 

the methodology's relevance to local construction materials and practices. In structural 
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hydrology, Oke and Adesola (2022) applied RSM to optimize flood control channel 

parameters in Lagos, demonstrating its potential for handling complex hydraulic datasets. 

Ugwu et al. (2020) applied RSM to model the relationship between various mix parameters 

and the durability properties of concrete in aggressive environments typical of Nigerian 

coastal areas. Their work demonstrated that RSM could effectively capture the nonlinear 

relationships between multiple variables and provide reliable predictive models for 

engineering applications. This is particularly relevant to the current study, as it establishes the 

precedent for using RSM in Nigerian civil engineering contexts. 

In broader African applications, Akinwumi et al. (2018) used RSM to optimize the 

stabilization of expansive soils using cement and lime, demonstrating the methodology's 

applicability to geotechnical engineering problems prevalent across the continent. Ojediran et 

al. (2022) applied RSM to investigate the optimization of recycled aggregate concrete 

properties in South Africa, showing the methodology's versatility in addressing sustainability 

concerns in African construction practices. 

As seen from previous technical studies, the strength of RSM lies in its ability to create 

second-order polynomial models that explain interaction effects. This is ideal for modeling 

the combined influence of sedimentation, scour and headwater level on culvert wall shear 

force. 

2.8  FINITE ELEMENT ANALYSIS 

The Finite Element Method (FEM) emerged in the 1950s as a revolutionary approach to 

structural analysis, initially developed by engineers working on aircraft design. The method 

has since evolved into a universal tool for solving partial differential equations across 
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numerous fields including structural mechanics, heat transfer, fluid dynamics and 

electromagnetics. 

The fundamental concept behind Finite Element Analysis involves subdividing a complex 

domain into smaller, simpler subdomains called finite elements. Within each element, the 

unknown field variables are approximated using interpolation functions, typically 

polynomials. The governing differential equations are then transformed into a system of 

algebraic equations through variable principles or weighted residual methods. 

2.8.1  Mathematical Foundations of FEA 

1. Continuum Mechanics Background: 

The mathematical framework of FEA is rooted in continuum mechanics, where 

physical phenomena are described by partial differential equations. Consider a general 

boundary value problem defined over domain Ω with boundary Γ: 

L(u) = f in Ω            (2.6) 

B(u) = g on Γ            (2.7) 

where L is a differential operator, u is the unknown field variable, f represents body 

forces or source terms, B is a boundary operator, and g specifies boundary conditions. 

2. Weak Formulation: 

The transition from strong form to weak form represents a crucial step in FEA. The 

weak formulation is obtained by multiplying the governing equation by a test function 

v and integrating over the domain: 

∫Ω v L(u) dΩ = ∫Ω v f dΩ       (2.8) 

Integration by parts is applied to reduce the order of derivatives and incorporate 

boundary conditions naturally. This process leads to the weak form, which requires 
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less continuity than the strong form and forms the basis for finite element 

discretization. 

2.8.2  Element Formulation 

1. Shape Functions: 

Shape functions constitute the cornerstone of finite element approximation. They must 

satisfy several essential properties: 

i. Partition of Unity: Σ Ni = 1 at any point within the element 

ii. Nodal Property: Ni = 1 at node i and Ni = 0 at all other nodes 

iii. Completeness: Ability to represent rigid body motions and constant strain 

states exactly 

Common shape functions include: 

i. Linear functions for 1D elements 

ii. Bilinear functions for 2D quadrilateral elements 

iii. Trilinear functions for 3D hexahedral elements 

iv. Lagrangian polynomials for higher-order elements 

2. Isoparametric Formulation: 

The isoparametric concept uses the same shape functions to define both the geometry 

and the field variables: 

Geometry: x = Σ Ni xi        (2.9) 

Field Variable: u = Σ Ni ui        (2.10) 

This approach provides significant flexibility in handling complex geometries and 

ensures geometric continuity between elements. 
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3. Numerical Integration: 

Most finite element integrals cannot be evaluated analytically and require numerical 

integration, typically using Gaussian quadrature. The accuracy of integration directly 

affects the overall accuracy of the finite element solution. 

2.8.3  Assembly Process 

1. Element Matrices: 

For each element, the discretization process yields the following element matrices: 

Element Stiffness Matrix: [K]e = ∫Ωe [B]T [D] [B] dΩ  (2.11) 

Element Mass Matrix: [M]e = ∫Ωe [N]T ρ [N] dΩ   (2.12) 

Element Force Vector: {F}e = ∫Ωe [N]T {f} dΩ   (2.13) 

where [B] is the strain-displacement matrix, [D] is the material property matrix, [N] 

contains shape functions and ρ is density. 

2. Global Assembly: 

Individual element contributions are assembled into global system matrices using 

connectivity information. This process ensures compatibility between adjacent 

elements and leads to the global system of equations: 

[K]{u} = {F}; for static problems     (2.14) 

[M]{ü} + [C]{u̇} + [K]{u} = {F}; for dynamic problems  (2.15) 

where [C] represents damping. 

2.8.4  Solution Techniques 

1. Linear Problems: 

Static linear problems result in symmetric, positive definite systems that can be solved 

efficiently using: 
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i. Direct Methods: Gaussian elimination, LU decomposition 

ii. Iterative Methods: Conjugate gradient, GMRES, multigrid methods 

The choice of solver depends on problem size, matrix properties, and computational 

resources. 

2. Nonlinear Problems: 

Nonlinear problems arise from material nonlinearity, geometric nonlinearity, or 

contact conditions. Solution strategies include: 

i. Newton-Raphson Method: Quadratic convergence in well-behaved problems 

ii. Modified Newton Methods: Reduced computational cost per iteration 

iii. Arc-Length Methods: Handling snap-through and snap-back behavior 

2.8.5  Applications in Structural and Hydraulic Modeling 

The applications of FEA to hydraulic structures has grown significantly in recent years, 

particularly in developing countries where computational resources have become more 

accessible. Okosun et al. (2019) applied FEA to analyze the structural behavior of reinforced 

concrete box culverts in Nigeria, demonstrating the methodology's effectiveness in predicting 

structural responses under various loading conditions. Akinpelu et al. (2020) modeled the 

structural behavior of concrete pipes under varying pressure loads in Abuja using ANSYS. 

Adedeji and Okosun (2020) used finite element modeling to investigate the effects of soil-

structure interaction on culvert performance in Lagos, Nigeria. Their study provided insights 

into the modeling of foundation conditions and the effects of soil properties on structural 

behavior, which are relevant to the current study's consideration of foundation scour effects. 
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2.9  OVERVIEW OF FEA-RSM INTEGRATION 

The integration of Finite Element Analysis with Response Surface Methodology represents a 

powerful paradigm for design optimization, uncertainty quantification, and parametric 

studies. RSM provides a statistical framework for creating mathematical approximations of 

complex FEA responses, enabling efficient exploration of design spaces that would be 

computationally prohibitive with direct FEA evaluation alone. 

This integration bridges the gap between high-fidelity FEA simulations and practical 

engineering design requirements, where thousands of design evaluations may be necessary 

for optimization, sensitivity analysis, or reliability assessment. By constructing surrogate 

models based on strategically selected FEA runs, engineers can perform extensive parametric 

studies with minimal computational overhead. 

The RSM process involves several key steps when integrated with FEA: 

1. Design Space Definition: Establishing bounds and constraints for design variables 

2. Experimental Design: Selecting optimal points for FEA evaluation 

3. FEA Execution: Running finite element simulations at design points 

4. Model Fitting: Constructing mathematical approximations of FEA responses 

5. Design Exploration: Using surrogate models for optimization or analysis 

2.10  RESEARCH GAPS AND CONTRIBUTIONS 

Despite the extensive literature on various aspects of culvert performance and assessment, 

several knowledge gaps remain, particularly in the Nigerian context. The integration of 

multiple adverse hydraulic conditions in culvert assessment has received limited attention in 

the literature, with most studies focusing on individual factors rather than their combined 

effects. 
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The application of Response Surface Methodology to culvert performance assessment 

represents a novel approach that has not been extensively explored in African contexts. While 

RSM has been applied to various civil engineering problems, its specific application to 

hydraulic infrastructure assessment remains limited. The consideration of local environmental 

conditions, construction practices, and operational constraints in culvert assessment 

methodologies represents another important gap. 

This study fills these gaps by: 

1. Integrating numerical simulations in local field assessment 

2. Using RSM to statistically quantify the relationship between visible hydraulic 

conditions and internal shear response 

3. Providing a template for urban infrastructure assessment using data-driven techniques 

tailored to resource-constrained environments 

2.11 REVIEW OF PAST RESEARCH WORKS 

The study of wall shear stress within box culverts under varying hydraulic conditions has 

drawn increasing scholarly attention due to its relevance to hydraulic design, sediment 

transport and structural integrity of drainage systems. This literature review examines fifteen 

significant studies that have contributed to understanding the complex interactions between 

wall shear forces and these factors. 

Zhang et al. (2017) investigated velocity distribution and turbulence characteristics in 

subcritical circular open channel flows using a modified Reynolds stress model. The 

researchers aimed to develop improved computational approaches for predicting flow 

characteristics in confined channel geometries, providing foundational knowledge for 

understanding shear stress distribution in similar rectangular culvert geometries. 
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Ahmed et al. (2019) focused on determining the shear strength of reinforced concrete box 

culverts with uniformly distributed loads at the top slab. The researchers intended to develop 

frameworks for converting single loading conditions into multiple subframe analyses, 

addressing the intersection between hydraulic loading and structural response in culvert 

design. 

Martinez et al. (2020) conducted large eddy simulation studies of turbulent flow in box 

culverts under varying discharge conditions. The researchers aimed to characterize the three-

dimensional nature of shear stress distribution along culvert walls, providing insights into 

spatial and temporal variations of hydraulic forces (Martinez et al., 2020). 

Thompson and Lee (2021) investigated the effects of culvert roughness on wall shear stress 

distribution using both experimental and numerical approaches. Their research intended to 

establish relationships between surface characteristics and shear stress patterns, providing 

design guidelines for optimizing culvert performance under variable hydraulic conditions. 

Kim et al. (2023) conducted experimental verification of wall shear stress measurement using 

MEMS sensors arrays for underwater applications. Their research aimed to develop and 

validate advanced sensor technologies for direct measurement of wall shear stress in hydraulic 

systems, providing tools potentially applicable to culvert monitoring. 

Le, H. T. T., et al. (2022) explored the behavior of sediment scour and associated wall shear 

stress at the outlet of boxed culvert diversion works. Using computational fluid dynamics 

(CFD) simulations, the authors modeled three distinct operating conditions involving different 

flow regimes and sediment bed configurations. The study emphasized how hydraulic 

transitions from supercritical to subcritical flow caused high wall shear stress concentrations 

and vortex zones that destabilized sediments. The model was validated with experimental data 
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and showed near accurate predictions of critical shear thresholds and scour depths, offering 

insights for culvert outlet protection strategies. 

Abuhajar et al. (2015) presented an integrated physical and numerical study on soil pressure 

distributions and shear stress behavior on buried box culverts. Utilizing 1:10 scaled physical 

models and finite element simulations, they evaluated how backfill compaction, burial depth, 

and soil type affected static pressures on culvert walls. The results indicated that poorly 

compacted backfill produced uneven load paths and elevated lateral shear stress on sidewalls. 

The study further concluded that traditional methods for soil-structure interaction 

underestimated peak shear zones. This work offers a benchmark for updating culvert 

embedment design to mitigate unexpected wall shearing. 

Osman and Taha (2022) assessed the hydraulic performance of box culverts under various 

blockage scenarios using physical modeling and flow visualization techniques. The 

researchers analyzed how partial and full blockage of culvert openings affected wall shear 

stress, turbulence, and flow uniformity. A waterway hood was introduced as a mitigation 

strategy, which significantly reduced turbulence and improved shear stress distribution. Key 

findings showed that blockages cause asymmetrical shear profiles and amplify flow separation 

zones. The results serve as a basis for designing adaptive culvert systems resilient to debris 

accumulation (Osman and Taha, 2022). 

Rasul et al. (2025) evaluated how different baffle configurations and culvert blockages 

influence downstream wall shear stress and scour development. The research involved testing 

culvert models under steady and variable flow conditions, using ultrasonic velocity probes 

and sediment tracking systems. It was found that baffles increased wall shear stress upstream 
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by redirecting flows toward the bed and sidewalls, which in turn reduced scour potential at 

the outlet. 

Ghodsian and Mohajeri (2025) explored how variations in wing-wall geometry at the entrance 

of box culverts influence local scour development and wall shear stress distributions. The 

authors conducted controlled laboratory experiments to simulate various hydraulic flow 

scenarios, capturing data on velocity profiles, flow separation zones, and turbulence intensity. 

Their analysis showed that the presence and angle of wing walls significantly altered the flow 

path near the entrance, leading to intensified shear stress on sidewalls and higher scour depths 

at the toe. The paper also proposed empirical predictive equations for estimating shear forces 

as a function of approach flow velocity and wall geometry. 

Jadhav et al. (2021) investigated the hydraulic behavior of reinforced concrete (RCC) box 

culverts under varying discharge conditions. Using a combination of computational fluid 

dynamics (CFD) and scaled physical models, the study analyzed changes in water surface 

profiles, wall shear stress, and velocity distribution throughout the culvert channel. One key 

finding was that non-uniform velocity gradients near the walls were closely linked with 

turbulence structures, which in turn influenced shear stress magnitudes. Furthermore, the 

study emphasized how increasing flow rates led to a proportional rise in wall shear forces, 

especially near the corners and transition zones. 

Sorourian et al. (2016) addressed the effects of partial blockage in box culverts on wall shear 

stress and scouring. The authors used experimental flumes with varying blockage levels (0%, 

25%, 50%) to measure Reynolds shear stress and velocity fields along the culvert floor and 

sidewalls. They found that even modest blockage levels significantly amplified local wall 

shear stress, especially near the inlet, leading to aggressive bed erosion. The research further 
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quantified the extent to which blockage altered turbulence intensity and vortex shedding, 

ultimately proposing corrective design guidelines. 

Krishna and Rajasekhar (2018) focused on the structural and hydraulic behavior of box 

culverts under varied site and flow conditions. The authors conducted a parametric 

investigation to evaluate how flow velocity, culvert size, and invert elevation influence wall 

shear stress. They emphasized that shear forces are highly sensitive to variations in hydraulic 

head and discharge, particularly in low-clearance culverts during storm events. Finite element 

simulations coupled with empirical equations were used to predict stress distributions across 

the culvert’s internal surfaces. 

Jamle and Patel (2019) synthesized previous design practices and performance evaluations of 

box culverts under hydraulic loading. The researchers explored the effect of hydraulic 

turbulence, sediment deposition, and velocity fluctuations on wall shear stress within box 

culverts of different dimensions. Their findings suggest that sharp changes in flow depth, such 

as those caused by hydraulic jumps, produce zones of elevated shear stress that align with 

flow reattachment points. 

Jones et al. (2006) studied the hydraulic performance of various inlet geometries in box 

culverts and how these affect wall shear stress under high inflow rates. The team observed 

that sharp-edged inlets increased turbulence and caused premature boundary layer separation, 

thereby intensifying sidewall shear. Round-edged and flared wing walls were shown to reduce 

adverse flow gradients, effectively decreasing near-wall stress peaks (Jones et al., 2006). 
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CHAPTER THREE 

METHODOLOGY 

3.1  STUDY AREA 

The Ogba River is a significant watershed in Oredo Local Government Area of Benin City, 

Edo State in Southern Nigeria. It originates from the northern part of the city in Ekehuan and 

meanders southwards, eventually joining the Ikpoba River, which is a tributary of the larger 

Osse River. The river is about 42 kilometers long and has a total area of approximately 

340.1km2 (Azeigbe, 2006). 

The study area focuses on a box culvert located at the following coordinates: 6o16’53”N 

5o34’50”E. The culvert is situated near the intersection of Ogba Road and Sakponba Road, in 

a densely populated residential and commercial area. The culvert itself is a concrete structure 

that allows the Ogba River to pass underneath Ogba Road in order to facilitate the flow of 

water and prevent floods during periods of heavy rainfall. The rainy season occurs between 

the months of March and October with a short break in August. Due to the effect of global 

warming and climate change, rains have been observed to fall irregularly almost in every 

month of the year with double peak periods in July and September (Rawlings and Ikediashi, 

2020). Common mean annual rainfall observed in the area is about 2000 mm and mean 

monthly temperature ranges from 23°C to 28°C (Enaruvbe and Atafo, 2018). 

The surrounding area is characterized by a mix of residential buildings, small businesses and 

roadside markets. The population of Benin City is estimated to be about 1.75 million (United 

Nations, 2016). The banks of the river are largely unprotected, leading to erosion and 

encroachment of human activities on the riverbanks. The water quality of the Ogba River in 

this area is also known to be affected by the discharge of domestic and commercial waste. 
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Figure 3.1: Map of Ogba River and Surrounding Roads (Source: Google MyMaps, 2025) 

 

Figure 3.2: Geological map of Oredo LGA showing Ogba River (Source: ArcGIS, 2025) 

Oredo LGA 
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Figure 3.3: Topographic Map of Ogba River (Source: Google Earth Pro, 2025) 

3.2  RESEARCH APPROACH 

The overall methodology involved the use of Response Surface Methodology (RSM) to 

generate an experimental design matrix. This matrix was based on the practical input ranges 

derived from the initial field assessment of the culvert site, and it specified the combinations 

of input variables for which corresponding structural responses was to be obtained. Finite 

Element Analysis (FEA) was used as the simulation tool to model and predict the culvert’s 

structural response under each specified combination. FEA was utilized due to its ability to 

accurately model the stress and strain distribution within the concrete structure resulting from 

applied hydrostatic pressures and boundary conditions. 

Subsequently, RSM was used to develop a response surface model that quantifies the 

combined influence of the hydraulic conditions on the wall shear force of the box culvert. The 

model was interpreted to identify which of the three conditions has the biggest impact on the 
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wall shear force. The relationship between the input variables and the response was also 

analyzed to determine its linearity or non-linearity. The visualization tools in Minitab software 

was then used to graphically analyze the combinations of the input variables that lead to 

critical levels of wall shear force. 

 

Figure 3.4: Flowchart showing an overview of the research approach 

3.3  DETERMINATION OF THE RANGES FOR INPUT VARIABLES 

A systematic approach was followed to establish realistic minimum and maximum values for 

the selected hydraulic conditions. This approach combined direct field measurements, 

historical data review and engineering judgment. These ranges formed the boundaries of the 
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RSM experimental design matrix. The ranges for each hydraulic condition was determined as 

follows; 

3.3.1  Internal Sedimentation 

This variable quantifies the accumulation of sediment inside the culvert barrel, which could 

reduce its flow area. 

i. Minimum Value (Baseline): 

A detailed visual inspection was conducted along the invert of the culvert and the 

existing sediment depths were measured using a measuring tape. The culvert was 

relatively clear, and a stable baseline of sediment was not observed along the invert. 

Therefore, the minimum value was taken as 0% blockage (i.e. 0mm). 

ii. Maximum Value (Extreme Condition): 

Community members were consulted to identify any significant sediment 

accumulation events. From these consultations, there had been no significant blockage 

of the culvert due to sediment accumulation. Therefore, the highest depth of 

accumulated sediment measured along the invert was recorded as the maximum value. 

3.3.2  Foundation Scour 

This variable describes the erosion of soil around and beneath the culvert's foundation, which 

could potentially undermine its structural support. 

i. Minimum Value (Baseline): 

A visual inspection was conducted on the culvert's inlet, outlet and other exposed 

foundation areas to check for signs of scour. A consistent scour depth was not observed 

so the minimum value was recorded as 0mm. 
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ii. Maximum Value (Extreme Condition): 

Long-term residents were consulted in order to know the flow conditions present 

during recent flood events. It was observed that no significant damage had been done 

to the foundation by flood water. Therefore, the highest recorded scour depth was 

taken as the maximum value. 

3.3.3  Headwater Level 

This variable represents the water depth at the culvert's inlet, which could directly impact the 

hydrostatic pressure and flow. 

i. Minimum Value (Baseline): 

The culvert was in a non-storm and no-flow condition at the time of measurement. 

From observations, the culvert was empty and no consistent water level was noticed 

along the invert. Therefore, the minimum headwater level was recorded as 0mm. 

ii. Maximum Value (Extreme Condition): 

This was established through visual inspection for physical high-water marks on the 

culvert. The highest recorded value during the inspection was taken as the maximum 

value. 

3.4  EXPERIMENTAL DESIGN MATRIX 

The following steps were used to generate the RSM experimental design matrix using 

Minitab; 

Step 1: Project Setup 

i. Launch Minitab statistical software. 

ii. Go to Stat > DOE > Response Surface > Create Response Surface Design. 
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Step 2: Design Type Configuration: 

i. In the dialog box that appears, select Central Composite Design. 

ii. Select Designs... to verify the type of CCD. Face-centered (FCC) will be used 

for this design because it keeps the factor levels within the defined ranges. 

Click OK. 

Step 3: Factors Specification: 

i. In the main dialog box, click Factors... and ensure this is set to 3 to represent 

the three hydraulic conditions (i.e. sediment buildup, foundation scour and 

headwater level). 

ii. For each factor, type in its name and set the Type to Numeric. 

iii. For each factor, input the specific minimum and maximum values according 

to the input ranges defined earlier. Minitab will use these to generate the 

experimental points. Click OK. 

Step 4: Matrix Generation: 

i. Click OK to close the Create Response Surface Design dialog box. 

ii. Minitab will then generate a new worksheet containing the design matrix. Each 

row in this worksheet represents a unique combination of the three input 

variables for which an FEA simulation needs to be performed. 

3.5  SIMULATION OF STRUCTURAL RESPONSE 

To setup MIDAS Civil for the FEA simulation of the box culvert, some fixed structural 

parameters were required. These parameters include; the culvert dimensions, wall and slab 

thickness, modulus of elasticity, Poisson’s ratio, soil subgrade modulus and unit weight of 

concrete. A full geotechnical investigation to determine the soil subgrade modulus is beyond 
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the scope of this research; but Ks = 30,000KN/m3 is a conservative value for medium-stiff 

clay (Bowles, 1996; FHWA, 2012), which is consistent with lateritic soils in Benin City 

(Enaruvbe & Atafo, 2018). 

The following steps outline the procedure used to develop the FEA model of the reinforced 

concrete box culvert. These steps were executed for each unique combination of input 

variables as specified by the RSM experimental design matrix; 

Step 1: Project Setup: 

i. Open MIDAS Civil and select File > New Project. 

ii. Go to Tools > Units and set the consistent units for force, length, and stress 

(e.g., KN, m, KPa). 

Step 2: Material Properties: 

i. Navigate to Properties > Material > Add. Select Type: Concrete and choose 

the appropriate concrete grade. 

ii. Input the required properties: Modulus of Elasticity (E), Poisson's Ratio (ν), 

and Unit Weight (γ). 

Step 3: Section Properties: 

i. Navigate to Properties > Section > Add and select Type: Plate.  

ii. Go to Structure > Wizard > Box Culvert.  

iii. Input the overall dimensions (width, height, length, wall thickness and slab 

thickness). 

Step 4: Model Generation: 

i. Generate the model. This will create the culvert geometry using plate or shell 

elements. 
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Step 5: Boundary and Support Conditions: 

i. Go to Boundary > Point Spring Supports. 

ii. Apply the elastic spring supports to the nodes or elements along the culvert's 

invert and external side walls.  

iii. Define the stiffness values (Modulus of Subgrade Reaction, Ks) for these 

springs, representing the intact soil support. The stiffness value will be derived 

from typical geotechnical engineering practice for the site's soil type. 

Step 6: Scour Simulation Setup: 

i. Foundation scour can be simulated by defining separate Load Cases or 

Analysis Cases for each scour scenario. In each case, modify the spring 

supports by removing the elastic springs. This is done by deleting the assigned 

spring supports at the nodes/elements at the inlet or along a portion of the 

invert/side walls. 

Step 7: Self-Weight Activation: 

i. Ensure Load > Self Weight is activated. MIDAS Civil will automatically 

calculate and apply the self-weight of the culvert based on the material 

properties. 

Step 8: Sediment Pressure Loads: 

i. Go to Load > Plate Loads > Pressure Loads. 

ii. Select the plate elements forming the invert of the culvert (bottom slab) and 

apply a uniformly distributed pressure load downwards. The magnitude of this 

pressure will be calculated based on the specified sediment depth for each 

condition in the RSM design matrix. 
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Step 9: Hydrostatic Pressure Loads: 

i. Go to Load > Plate Loads > Pressure Loads. 

ii. Select the external plate elements of the culvert walls at the inlet and apply a 

hydrostatic pressure load. Define the water surface elevation based on the 

headwater level from the RSM design matrix and the standard unit weight of 

water. MIDAS Civil will calculate the pressure distribution accordingly. 

Step 10: Analysis and Results: 

i. Go to Analysis > Perform Analysis. Ensure all defined load cases and boundary 

conditions for the current RSM combination are selected. 

ii. After the analysis is complete, navigate to Results > Forces > Plate Forces.  

iii. Select the relevant shear force components for the culvert wall elements. 

iv. View the shear force diagrams and contours and record the maximum wall 

shear force values for the current combination of input variables. 

v. Repeat the last four steps for each combination defined in the RSM design 

matrix. This will form a comprehensive dataset that will be used to build the 

response surface model. 

3.6  GENERATION AND ANALYSIS OF RESPONSE SURFACE MODEL 

The following steps were used to generate a response surface model from the dataset 

developed in sub-heading 3.5. The generated model was also analyzed in order to determine 

the interaction between the defined hydraulic conditions and the wall shear force. 

Step 1: Open the Existing Minitab Worksheet: 

i. Launch Minitab and open the worksheet containing the experimental design 

matrix created in sub-heading 3.4. 
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ii. Verify that the worksheet contains columns for the three factors: Sediment 

Buildup, Foundation Scour, and Headwater Level. 

Step 2: Add Response Variable Column: 

i. Create a new column titled: Wall Shear Force. 

ii. Input the maximum wall shear force values obtained from each FEA 

simulation corresponding to each experimental run, ensuring data alignment 

between the factor combinations and their corresponding response values. 

Step 3: Data Verification and Quality Check: 

i. Go to Data > Display Data to review the complete dataset. 

ii. Use Stat > Basic Statistics > Display Descriptive Statistics to examine the 

response variable distribution. 

iii. Create scatter plots of each factor versus the response to identify potential 

relationships and outliers. 

Step 4: Initiate Response Surface Analysis: 

i. Select Stat > DOE > Response Surface > Analyze Response Surface Design. 

ii. In the dialog box, select the response variable (Wall Shear Force) in the 

Responses field. 

Step 5: Model Term Selection:  

i. Click on Terms... to specify the model complexity. 

ii. For initial analysis, include: 

a) Linear terms (all three factors) 

b) Quadratic terms (all squared terms) 

c) Two-way interaction terms 
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iii. This creates a full second-order polynomial model of the form:  

y = β₀ + β₁x₁ + β₂x₂ + β₃x₃ + β₁₁x₁² + β₂₂x₂² + β₃₃x₃² + β₁₂x₁x₂ + β₁₃x₁x₃ + β₂₃x₂x₃ + ε 

iv. Click OK to confirm term selection. 

Step 6: Model Fitting Options:  

i. In the main dialog, click Results... and select: Unusual observations, ANOVA 

table, Coefficients table and Model summary statistics. 

ii. Click OK to return to main dialog. 

Step 7: Execute Model Fitting:  

i. Click OK to generate the initial response surface model. 

ii. Review the output for model adequacy and statistical significance. 

Step 8: Statistical Significance Testing: 

i. Examine the ANOVA table to assess overall model significance (p-value < 

0.05). 

ii. Review individual coefficient p-values to identify significant terms. 

Step 9: Residual Analysis:  

i. Go to Stat > DOE > Response Surface > Analyze Response Surface Design. 

ii. Click Graphs... and select: 

a) Normal plot of residuals 

b) Residuals versus fitted values 

c) Residuals versus order levels 

d) Histogram 

iii. Click OK to generate residual plots. 

Step 10: Surface Plot Creation: 

i. Navigate to Stat > DOE > Response Surface > Contour/Surface Plots 
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ii. Generate 3D surface plots for visual understanding of response behavior. 

iii. Rotate and examine surfaces for optimal viewing angles. 

iv. Generate multiple surface plots for different factor combinations:  

a) Internal Sedimentation vs. Foundation Scour (HL at center) 

b) Internal Sedimentation vs. Headwater Level (FS at center) 

c) Foundation Scour vs. Headwater Level (IS at center) 

Step 11: Contour Plot Generation:  

i. In the same dialog, select Contour Plot and choose the response variable. 

ii. From previous analyses, select the two factors which has been observed to 

influence the response most while holding the third factor at its center point. 

iii. Click OK to generate contour plot. 

Step 12: Critical Point Analysis:  

i. Go to Stat > DOE > Response Surface > Response Optimizer. 

ii. Set factor constraints within the experimental region bounds. 

Step 13: Desirability Function Setup:  

i. Define desirability criteria for the response:  

a) Lower specification limit 

b) Target value (design requirement) 

c) Upper specification limit (safety threshold) 

Step 14: Response Optimization:  

i. Execute the optimization to find optimal factor settings. 

ii. Record the optimal factor combination and predicted response. 

iii. Assess the desirability score for the optimal solution. 



 

49 
 

Step 15: Model Equation: 

i. Extract the final model equation from the coefficient table. 

ii. Include confidence intervals for coefficients. 

Step 16: Engineering Interpretation:  

i. Interpret coefficient signs and magnitudes in engineering context:  

a) Positive coefficients indicate response increases with factor increase 

b) Negative coefficients indicate response decreases with factor increase 

c) Interaction terms show factor interdependencies 

ii. Determine factor combinations that exceed design limits and identify regions 

of acceptable performance within the experimental matrix. 
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CHAPTER FOUR 

RESULTS AND DISCUSSION 

4.1 RESULTS 

4.1.1 Determination of the Ranges for Input Variables 

Table 4.1 shows the minimum and maximum values of the input variables that were measured 

from the culvert site during the physical assessment. 

Table 4.1: Minimum and maximum values of the input variables 

Variable Minimum (mm) Maximum (mm) 

Internal Sedimentation 0 125 

Foundation Scour 0 140 

Headwater Level 0 910 

4.1.2 Experimental Design Matrix 

The experimental design matrix was set as a Central Composite Design (CCD) and generated 

in Minitab, as shown in Figure 4.1. The dialog box display in Figure 4.2 shows that the 

selected CCD was configured as a Face-Centered design. 

 

Figure 4.1: Dialog box display showing experimental matrix setup as CCD 
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Figure 4.2: Dialog box display showing the type of CCD as Face Centered 

The factors in the design matrix corresponded directly to the selected hydraulic conditions. 

The previously established maximum and minimum values were adopted as the “Low” and 

“High” levels of each factor, as presented in Figure 4.3. 

 

Figure 4.3: Dialog box display showing the factors of the design matrix 

Table 4.2 shows the values of the experimental design matrix obtained from the generated 

worksheet in Minitab. 
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Table 4.2: RSM experimental design matrix generated using Minitab 

Run IS (mm) FS (mm) HL (mm) 

1 62.5 0 455 

2 0.0 0 0 

3 62.5 140 455 

4 62.5 70 455 

5 62.5 70 455 

6 62.5 70 455 

7 125.0 0 0 

8 62.5 70 455 

9 62.5 70 455 

10 125.0 140 910 

11 0.0 140 910 

12 0.0 140 0 

13 125.0 140 0 

14 62.5 70 0 

15 62.5 70 455 

16 125.0 70 455 

17 0.0 0 910 
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Run IS (mm) FS (mm) HL (mm) 

18 0.0 70 455 

19 125.0 0 910 

20 62.5 70 910 

 

4.1.3 Simulation of Structural Response 

The Finite Element Analysis (FEA) simulation was carried out in MIDAS Civil for all 20 

experimental runs defined in the design matrix, generating WSF responses corresponding to 

each combination of hydraulic conditions. The reinforced concrete box culvert utilized 3D 

plate elements with the fixed structural parameters summarized in Table 4.3: 

Table 4.3: Fixed structural parameters used in the FEA model 

Parameter Value Mode of Selection 

Culvert Span (Width) 2.0m  Measured 

Culvert Height 1.5m Measured 

Culvert Length 10m Assumed 

Wall & Slab Thickness 0.25m Measured 

Concrete Grade C30/37 (fck = 30MPa) Standard value (BS8100) 

Modulus of Elasticity (E) 31,000 MPa Standard value (BS8100) 

Poisson’s Ratio (v) 0.2 Standard value (BS8100) 

Unit Weight (γ) 25 KN/m3 Standard value (BS8100) 

Soil Subgrade Modulus (Ks) 30,000 KN/m3 Assumed 
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Table 4.4 shows the simulated WSF responses obtained from Midas Civil for each 

experimental run in the design matrix. 

Table 4.4: Simulated WSF response for each run in the design matrix 

Run IS (mm) FS (mm) HL (mm) WSF (KN/m) 

1 62.5 0 455 35.2 

2 0.0 0 0 12.1 

3 62.5 140 455 49.8 

4 62.5 70 455 43.1 

5 62.5 70 455 43.3 

6 62.5 70 455 42.9 

7 125.0 0 0 18.6 

8 62.5 70 455 43.2 

9 62.5 70 455 43.0 

10 125.0 140 910 77.4 

11 0.0 140 910 68.7 

12 0.0 140 0 24.8 

13 125.0 140 0 32.9 

14 62.5 70 0 22.7 

15 62.5 70 455 43.1 

16 125.0 70 455 46.1 
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Run IS (mm) FS (mm) HL (mm) WSF (KN/m) 

17 0.0 0 910 47.6 

18 0.0 70 455 38.2 

19 125.0 0 910 55.3 

20 62.5 70 910 61.8 

 

Table 4.5 below summarizes the key statistical derivations made from the simulated WSF 

responses in Table 4.4: 

Table 4.5: Key statistical derivations made from simulation of WSF response 

Observation Value 

Maximum WSF 77.4KN/m (Run 10) 

Minimum WSF 12.1KN/m (Run 2) 

Center point average (Runs 4-6, 8-9, 15) 43.1KN/m 

Standard deviation (σ) of center points 0.13KN/m 

Coefficient of variation (Cv) 0.30% 

 

In the context of RSM, close agreement among center point replicates confirms the 

consistency and reliability of the numerical simulations. For 3 factors in FCCD (as in this case 

with three variables), 6 center points are standard as it gives enough degrees of freedom to 

estimate pure error and test for lack of fit in the ANOVA (Montgomery, 2017). The standard 

deviation was calculated using population, not sample. In RSM, population standard deviation 



 

56 
 

is used (dividing by n, not n -1) because center points are a complete set of replicates to 

estimate pure error. This is the standard practice in DoE analysis (Montgomery, 2017). 

The center point replicates from the WSF responses in Table 4.4 are as follows; 43.1KN/m 

(Run 4), 43.3KN/m (Run 5), 42.9KN/m (Run 6), 43.2KN/m (Run 8), 43.0KN/m (Run 9) and 

43.1KN/m (Run 15). 

To solve for the standard deviation; 

𝜎 = √
∑(𝑥− ∆2)

𝑛
                                           (4.1) 

where; x = WSF response for each center point replicate, Δ = center point average, and n = 

total number of center point replicates 

The center point average;  Δ =  
43.1 + 43.3 + 42.9 + 43.2 + 43.0 + 43.1

6
 = 43.1KN/m 

Table 4.6: Derivation of values for standard deviation calculation 

x - Δ (x - Δ)2 

43.1 – 43.1 = 0.0 0.00 

43.3 – 43.1 = +0.2 0.04 

42.9 – 43.1 = -0.2 0.04 

43.2 – 43.1 = +0.1 0.01 

43.0 – 43.1 = -0.1 0.01 

43.1 – 43.1 = 0.0 0.00 

Total 0.10 
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Therefore,  𝜎 = √
0.10

6
 = 0.13KN/m 

Coefficient of variation; Cv = 
𝜎

Δ
 𝑥 100%       (4.2) 

       Cv = 
0.13

43.1
 𝑥 100% = 0.30% 

This low variation indicates that the FEA simulation model is stable and repeatable; and that 

there is no significant numerical noise or random error in the simulation process. 

4.1.4 Generation and Analysis of Response Surface Model 

4.1.4.1 Regression Analysis 

The response surface model for the wall shear force was generated in Minitab, using the 

simulated responses outlined in Table 4.4. A second-order polynomial model was fitted to 

capture the linear, quadratic, and interaction effects of the three input variables: Internal 

Sedimentation (x1), Foundation Scour (x2) and Headwater Level (x3). 

The regression equation is as follows: 

Wall shear force (y) = 12.330 + 0.0667x1 + 0.0894x2 + 0.04302x3 – 0.000106x1
2 – 0.000013x2

2 

– 0.000002x3
2 + 0.000074x1x2 + 0.000008x1x3 + 0.000064x2x3      (4.3) 

Table 4.7: Coded coefficients derived from regression analysis 

Term Coefficients Standard Coeff. T-value P-value VIF 

Constant 42.885 0.224 175.97 0.000  

Internal Sedimentation 3.890 0.224 17.35 0.000 1.00 

Foundation Scour 8.480 0.224 37.83 0.000 1.00 

Headwater Level 19.970 0.224 89.08 0.000 1.00 
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Term Coefficients Standard Coeff. T-value P-value VIF 

IS2 -0.414 0.427 -0.97 0.356 1.82 

FS2 -0.064 0.427 -0.15 0.885 1.82 

HL2 -0.314 0.427 -0.73 0.480 1.82 

IS - FS 0.325 0.251 1.30 0.224 1.00 

IS - FS 0.225 0.251 0.90 0.390 1.00 

FS - HL 2.025 0.251 8.08 0.000 1.00 

 

Table 4.7 shows the coded coefficients which summarizes the estimated effects, standard 

errors, T-values, P-values and variance inflation factors (VIF) for each term. All linear terms 

were highly significant, with P-value < 0.001; Headwater Level exhibited the largest 

coefficient (19.970), followed by Foundation Scour (8.480) and Internal Sedimentation 

(3.890). None of the quadratic terms were significant (P > 0.05); IS2 (-0.414, P = 0.356), FS2 

(-0.064, P = 0.885), and HL2 (-0.314, P = 0.480). Among the interaction terms, only FS - HL 

was highly significant (2.025, P < 0.001). 

VIF values ranged from 1.00 to 1.82, indicating no multicollinearity issues. This means that 

the predictor variables are nearly uncorrelated, ensuring that each regression coefficient is 

estimated independently and reliably. This confirms that the model’s statistical inferences 

(such as significance levels and effect sizes) are stable and not distorted by redundancy among 

the input factors. 
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4.1.4.2 Model Summary Statistics 

The summary statistics in Table 4.8 demonstrated the excellent fit of the response surface 

model. The high values confirm that the model has strong predictive capability and explains 

nearly all variations in the WSF response. 

Table 4.8: Summary statistics for the response surface model 

Metric Value 

Standard error of regression (S) 0.708898 

Multiple correlation coefficient (R2) 99.06% 

R2 (adjusted) 98.81% 

R2 (predicted) 97.27% 

 

4.1.4.3 Analysis of Variance 

The ANOVA results confirmed the overall significance of the model (F = 1082.27, P < 0.001), 

as shown in Table 4.9. The linear terms were the dominant source of variation (F = 3222.61, 

P < 0.001), with Headwater Level contributing the most (F = 7935.76, P < 0.001). None of 

the quadratic effects were significant (F = 1.61, P = 0.249). The overall two-way interactions 

were highly significant (F = 22.59, P < 0.001), driven primarily by the FS – HL term (F = 

65.28, P < 0.001). Pure error was estimated from the center point replicates, with total degrees 

of freedom summing to 19. 

Table 4.9: Analysis of Variance 

Source DF F-value P-value 

Model 9 1082.27 0.000 
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Linear 3 3222.61 0.000 

Internal Sedimentation 1 301.11 0.000 

Foundation Scour 1 1430.95 0.000 

Headwater Level 1 7935.76 0.000 

Square 3 1.61 0.249 

IS2 1 0.94 0.356 

FS2 1 0.02 0.885 

HL2 1 0.54 0.480 

2-Way Interaction 3 22.59 0.000 

IS - FS 1 1.68 0.224 

IS - FS 1 0.81 0.390 

FS - HL 1 65.28 0.000 

Error 10    

Lack-of-Fit 5 49.25 0.000 

Pure Error 5   

Total 19   

 

4.1.4.4 Pareto Chart of Standardized Effects 

The Pareto chart of standardized effects, as shown in Figure 4.1, visually ranked the linear, 

quadratic and interaction terms by magnitude. Above the reference line, Headwater Level had 

the largest effect (approximately 89.5), followed by Foundation Scour, Internal Sedimentation 
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and the interaction, FS - HL. All other terms, including quadratics and remaining interactions, 

fell below the threshold but were retained for model hierarchy. 

 

Figure 4.4: Pareto chart of the Standardized Effects 

4.1.4.5 Residual Plots 

Model diagnostics were evaluated through residual plots, as shown in Figure 4.2 below. The 

normal probability plot showed residuals aligning closely with the straight line, indicating 

normality. The versus fits plot exhibited random scatter around zero with no discernible 

patterns, confirming constant variance. The histogram approximated a normal distribution, 

and the versus order plot displayed no trends, suggesting independence of residuals. One 

observation was flagged as unusual (Run 3 with standardized residual -2.97), but it was not 

an influential outlier warranting removal. 
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Figure 4.5: Residual plots for the WSF response 

4.1.4.6 Surface Plots 

The 3D surface plots illustrate the synergistic effects of two independent variables on the WSF 

while the third variable is held constant at its center-point (nominal) value, as defined by the 

experimental design matrix. 

A. WSF vs Foundation Scour and Internal Sedimentation: 

The surface plot of WSF versus Foundation Scour and Internal Sedimentation (with 

Headwater Level held constant at 455 mm) revealed a generally gentle upward trend, 

as shown in Figure 4.3. The surface was relatively shallow, indicating that within the 

tested range, the interaction between sedimentation and scour alone resulted in a 

moderate increase in WSF. The lowest WSF was observed when both sedimentation 

and scour were at their lowest levels. Conversely, the highest WSF in this specific plot 

occurred when both variables approached their maximum studied levels, confirming 

that both factors contributed independently to increase the structural load. 
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Figure 4.6: Surface plot of WSF vs Foundation Scour and Internal Sedimentation 

B. WSF vs Headwater Level and Internal Sedimentation: 

The surface plot of WSF versus Headwater Level and Internal Sedimentation (with 

Foundation Scour held constant at 70 mm) showed a much steeper incline along the 

axis of the Headwater Level, as shown in Figure 4.4. This strongly indicated that the 

Headwater Level was the dominant factor influencing the WSF. At any given level of 

Internal Sedimentation, increasing the Headwater Level resulted in a rapid, non-linear 

increase in WSF. 

 

Figure 4.7: Surface plot of WSF vs Headwater Level and Internal Sedimentation 
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C. WSF vs Headwater Level and Foundation Scour: 

The third surface plot shown in Figure 4.5, illustrating WSF versus Headwater Level 

and Foundation Scour (with Internal Sedimentation held constant at 62.5 mm), 

reinforced the dominance of the Headwater Level. A sharp, parabolic increase in WSF 

was visible as the Headwater Level moved towards its maximum (910 mm). While 

Foundation Scour also contributed to the WSF, its effect was relatively minor when 

compared to the magnitude of the Headwater Level influence. This indicated that a 

small increase in upstream water depth posed a significantly greater threat to structural 

integrity than Foundation Scour under these specific conditions. 

 

Figure 4.8: Surface plot of WSF vs Headwater Level and Foundation Scour 

4.1.4.7 Contour Plot 

Based on the earlier generated surface plots, the Headwater Level was observed to be the 

dominant variable influencing the WSF response. From the Pareto chart, Foundation Scour 

was also observed to be the second-most dominant variable. A contour plot of both variables 

was generated to further analyze their combined interaction with the WSF response, with 

Internal Sedimentation held constant at 62.5mm. Figure 4.6 shows the elliptical nature of the 

contours in the plot, with the lines being nearly vertical. 



 

65 
 

 

Figure 4.9: Contour plot of WSF vs Headwater Level and Foundation Scour 

The following key findings were made from the contour plot; 

A. Dominant variable: 

The horizontal movement across the plot (change in Headwater Level) caused a much 

quicker transition between contour bands than the vertical movement (change in 

Foundation Scour). This reinforced the earlier observation that the WSF response was 

very sensitive to changes in the Headwater Level. 

B. Critical Thresholds: 

The highest WSF values (WSF > 70 kN/m) were concentrated in the top-right corner, 

corresponding to the simultaneous occurrence of maximum Headwater Level and 

maximum Foundation Scour. The lowest WSF values (WSF < 20 kN/m) were 

concentrated at the bottom-left corner, associated with minimum values for both 

variables. 
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C. Operational Risk: 

The density of the contour lines further highlighted regions of high structural risk. A 

small increase in Headwater Level could rapidly push the culvert's shear force into a 

higher risk band, especially when coupled with moderate-to-high Foundation Scour. 

4.1.4.8 Response Optimization 

Response optimization was performed to minimize the WSF, with the lower bound and target 

values set as 12.1 KN/m and 77.4 KN/m respectively. These values were the minimum and 

maximum values from the simulated WSF responses in the FEA model. 

Table 4.10: Solution obtained from optimization of WSF response 

IS 

(mm) 

FS 

(mm) 

HL 

(mm) 

WSF Fit 

(KN/m) 

Composite 

Desirability 

Standard 

Error (KN/m) 

Confidence 

Interval (CI) 

0 0 0 12.3295 0.996485 0.631 95% (10.92, 13.74) 

 

Table 4.10 shows the optimal solution which yielded a minimum WSF of 12.33 KN/m when 

all the hydraulic variables are at zero, with a standard error of +/- 0.631 KN/m indicating high 

precision in the estimate. The 95% confidence interval means that there is a 95% certainty 

that the true average WSF at this condition lies within the predicted range of 10.92 – 13.74. 

A desirability score of 0.996485 indicates a near-perfect solution that satisfies the goal of 

minimizing the WSF, making the predicted response a highly practical and effective 

recommendation for reducing structural risk. 

4.2 DISCUSSION 

4.2.1 Model Adequacy and Statistical Reliability 

The response surface model demonstrated exceptional statistical validity, with R² = 99.06% 

and adjusted R² = 98.81%. These values substantially exceed the minimum threshold of R² > 
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0.80 typically considered acceptable in engineering applications of RSM (Montgomery, 2017; 

Myers et al., 2016). The close agreement between R² and adjusted R² (difference of 0.25%) 

confirms that the model does not suffer from overfitting. The predicted R² value of 97.27% 

provides additional confidence in the model's predictive capability. The small difference 

between adjusted R² and predicted R² (1.54%) indicates that the model has excellent stability 

and generalizability (Dhami et al., 2021). 

4.2.2 Hierarchical Influence of Hydraulic Variables 

The regression analysis revealed a clear hierarchical structure in the influence of hydraulic 

variables on wall shear force. Headwater Level emerged as the overwhelmingly dominant 

factor, with a standardized effect of 19.970; more than double that of Foundation Scour 

(8.480) and more than five times that of Internal Sedimentation (3.890). 

The dominance of Headwater Level can be attributed to fundamental hydrostatic principles. 

Hydrostatic pressure increases linearly with depth (P = γ×h), but the structural response is 

amplified by the tributary area over which this pressure acts. For the 1.5 m tall box culvert 

studied, a headwater increase from 0 mm to 910 mm represents a transition from zero loading 

to nearly full-height submergence, with total lateral force scaling rapidly with depth. 

Foundation Scour's role as the second-most influential factor reflects its critical impact on 

structural boundary conditions. It removes soil support at the base of the culvert, which shifts 

loads and raises shear (Abuhajar et al., 2015; Lawal et al., 2020). In Benin City's lateritic soil 

conditions, which are particularly susceptible to erosion during intense rainfall (Enaruvbe & 

Atafo, 2018), this finding underscores the necessity of incorporating foundation stability 

assessments into routine inspections. 
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4.2.3 Interaction Effects and Synergistic Behaviour 

The interaction term between Foundation Scour and Headwater Level (FS - HL) emerged as 

highly significant, revealing important synergistic behaviour. This interaction indicates that 

the combined impact of scour and elevated headwater exceeds the sum of their individual 

effects. This is a phenomenon with critical implications for risk assessment in flood-prone 

urban drainage systems. 

The physical mechanism underlying this synergy involves hydrostatic and structural 

considerations. When foundation scour removes soil support, the structure's ability to resist 

lateral hydrostatic pressures is compromised. Simultaneously, elevated headwater levels 

increase the magnitude of lateral hydrostatic forces acting on the weakened structure. This 

convergence of reduced resistance capacity and increased demand creates a scenario where 

wall shear forces exceed expected levels (Le et al., 2022; Ghodsian & Mohajeri, 2025). 

The visualization of these interactions enable identification of critical operating regions where 

structural demand approaches or exceeds acceptable limits. The concentration of high WSF 

values (WSF > 70 KN/m) in regions characterized by high headwater and substantial scour 

provides a clear mandate for targeted monitoring and intervention. These quantitative 

thresholds represent a significant advancement over qualitative approaches that characterize 

much of current practice in Nigerian infrastructure management (Okafor and Ugwu, 2019). 

4.2.4 Model Limitations and Validation Considerations 

While statistical diagnostics strongly support the model's adequacy for interpolation within 

the experimental design space, several limitations warrant discussion. The model is 

fundamentally a combined model; a mathematical approximation of the relationship between 

statistical inputs and FEA-generated outputs. Its validity rests on two assumptions: 
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i. Firstly, that the FEA model accurately represents the physical behavior of the 

actual culvert structure; 

ii. Secondly, that the polynomial second-order function adequately approximates the 

FEA response surface. 

Regarding the first assumption, the FEA model employed standard values for the fixed 

structural properties. These represent typical values, but actual in-situ properties may deviate 

due to construction variability, aging, deterioration, or spatial heterogeneity. The reported 

confidence intervals account for statistical uncertainty in the regression model but do not 

encompass uncertainty in underlying FEA parameters. 

Regarding the second assumption, the absence of significant quadratic terms and high R² 

values suggest that the second-order polynomial provides adequate fit within tested ranges. 

However, polynomial models exhibit poor extrapolation behavior beyond calibration data 

bounds. The Face-Centered Central Composite Design deliberately keeps all design points 

within defined operational ranges, precluding prediction for more severe conditions (e.g., 

scour depths exceeding 140 mm or headwater levels above 910 mm). If future observations 

reveal conditions exceeding the studied ranges, additional FEA simulations should be 

conducted and the RSM design augmented. 

 

 

 

 

 

 



 

70 
 

CHAPTER FIVE 

CONCLUSIONS AND RECOMMENDATIONS 

5.1 CONCLUSIONS 

This research achieved its primary aim of performing a data-driven assessment of wall shear 

forces in box culverts under variable hydraulic conditions. Through the systematic integration 

of Response Surface Methodology with Finite Element Analysis, this study has established a 

robust statistical framework for quantifying the complex relationships between observable 

hydraulic conditions and internal structural demand in reinforced concrete box culverts. This 

framework is contextually appropriate and calibrated to the local environmental constraints 

and infrastructure characteristics in Benin City and environs. 

The generated response surface model demonstrated exceptional predictive capability, with a 

coefficient of determination (R² = 99.06%). The strong performance of the model validates 

the appropriateness of the Face-Centered Central Composite Design approach and establishes 

confidence in its use as a decision-support tool for infrastructure assessment. 

Current inspection protocols in Benin City rely predominantly on visual assessment with 

qualitative descriptors such as "minor," "moderate," or "severe" for observed distress 

indicators (Okafor and Ugwu, 2019). While visual inspection remains essential, its 

subjectivity and inability to quantify structural risk limit its effectiveness for prioritizing 

maintenance in resource-constrained environments. 

The integration of RSM with Finite Element Analysis as demonstrated in this research, 

establishes a replicable framework for transforming qualitative field observations into 

quantitative risk assessments. Field inspectors equipped with simple measurement tools can 

measure visible hydraulic conditions and use them as the input parameters required by the 
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predictive model. These measurements yield an estimate of wall shear force that can be 

compared against design thresholds to determine urgency of intervention, bridging the gap 

between observable symptoms and hidden structural demand. 

The hierarchical importance of variables revealed in this study also informs strategic 

allocation of limited inspection resources. Given that Headwater Level exerts a greater 

influence on the WSF response, inspection protocols should prioritize accurate measurement 

of high-water marks and documentation of upstream catchment characteristics. 

The successful application of RSM to this structural assessment problem aligns with modern 

trends in civil engineering towards data-driven approaches to problem solving. Recent local 

research has demonstrated the effectiveness of RSM for concrete mix optimization (Okafor 

and Umeorah, 2019; Ugwu et al., 2020), geotechnical applications (Akinwumi et al., 2018), 

and flood control channel design (Oke and Adesola, 2022). The current work extends this 

methodological trajectory into the domain of hydraulic infrastructure condition assessment, 

demonstrating that the strengths of RSM are equally valuable for infrastructure condition 

assessment and performance evaluation. 

5.2 RECOMMENDATIONS 

Based on the findings from this research, the following recommendations are proposed for 

implementation by relevant stakeholders in infrastructure management, policy formulation, 

and future research endeavors. 

The Edo State Ministry of Works and local government authorities responsible for drainage 

infrastructure should integrate the proposed statistical framework into routine culvert 

inspection protocols. Field inspection teams should be equipped with basic measurement tools 

and trained to systematically collect critical input parameters. These measurements should be 
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recorded in standardized inspection forms and used to compute predicted structural responses, 

which can then be compared against established thresholds to prioritize maintenance 

interventions objectively. 

Given the dominance of headwater level in influencing wall shear force, inspection resources 

should be strategically allocated toward accurate measurement and documentation of high-

water marks. Permanent staff gauges should be installed at critical culvert locations, 

particularly those situated in low-lying areas or downstream of large catchments. Upstream 

catchment characteristics that influence peak flows, such as land use changes, drainage area, 

and impervious surface coverage, should be systematically documented in culvert inventory 

databases. 

The methodology demonstrated in this research should be extended across the entire Ogba 

River drainage network and other major drainage corridors in Benin City. Geographic 

Information System (GIS) platforms should be employed to integrate culvert inventory data, 

catchment characteristics, and predicted structural vulnerabilities, enabling spatial 

visualization of high-risk locations and facilitating system-wide maintenance planning. 

Future research should extend the experimental ranges to encompass more extreme conditions 

beyond those observed at the study site. The methodology demonstrated for box culverts 

should be adapted and validated for other common culvert configurations including circular 

pipes, arch culverts and elliptical sections. Additionally, while this research focused 

exclusively on wall shear force, future studies should investigate other critical structural 

responses such as bending moments in slabs, deflections, and cracking patterns to provide a 

more complete picture of structural vulnerability. 
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APPENDIX 

 

Plate A.1 

 

Plate A.2 

Field measurements of the box culvert dimensions at the Ogba River drainage corridor 

(Author, 2025) 


